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Connecting to an Excel File with Multiple Tabs

If the data you want to include in a Tableau visualization is included in a single excel file, Tableau provides the
tools to set up the relationship easily. To give you some experience in our second example, we’ll connect to
an excel file with more than one table or tab.

1. In Tableau, on the File menu click New to open a new session. Click the Go to Start Page icon.

\ File Data Worksheet Dashboard Story  Analysis Map  Format  Server Window  Help

.’ + -
i M & g- W - i - Norn}
F‘ Analytics N Pages i7" Columns

Connect to Data

R oyae

2 Click Excel to connect to an Excel file.
Select Headcnt_Fact and Dim combined.

Connect

Excel
tice t 2s from which to choose. Each of these represents a tab on the underlying
Access

Statistical File

Other Files

Sheets

Enter sheet name

FH Academic Program

EE Class

FE Headcount and Person Fact
EE Term
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4. Double-click the table you want to use for your primary connection. We’ll use Headcount and Person
Fact. This will show the table in the upper area of the connection window and the details for the table

into the preview pane.

L Headcount and Person Fact

Data doesn't look right? Tableau Data Interpreter might be able to help.
= Copy
Active Count Withdrawal Count Emplid Gender Ethnicity Student Term Academic O
# +#+ B #Abc Abc #Abc #Abc

1 0 333375445 F WHITE 1124 SPEC
1 0 333375564 M WHITE 1142 SPEC
1 0 333375767 M WHITE 1102 SPEC
1 0 333376564 F WHITE 1152 SPEC

5. Now select a second table to use. Double-click Class. Tableau will automatically select an inner join by
default. This will work if you want only members that exist in both tables.

Headcount and Person Fact

to

’

Il want

change to join type. To do this, click the overlapping circle. This will open the Join window.

Jaini

X

| @

-

Inner Right Full Outer
Data Source Class
Student Term = Student Term (Class)

Here you have the option to
select the join type you want and
to edit the field(s) used in the
join. Tableau will automatically
try to join on matching field
names. For our exercise, change
the join type to a left join by
clicking Left and then click the
red X to close the Join window.
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6. Next select a third table to use. Double-click the Academic Program. You'll notice several things. There is
a red exclamation point indicating that the join has no join clauses.

Th

Headcount and Person Fact

a doesn't lo

Academic Program

Jain

(9

Inner

Data Source

@

Left

EntEl' Text to Search

Academic Career

]

ac

rademic Pro

Active Count
Emplid
Ethnicity
Gender

Student Term

Withdrawal Code

Withdrawal Count
Classs

Class Acad Career

Class Acad Qrg

Class Mumber

Class Subject

Student Term (Class)

Acaderr]

‘Headcount and Person Facts'

Right Full Cuter

Academic Program

Primary Academic Program 1.

oqram

Academic Org
Abc Academic Program  3F

Class Mumber

e Join window is open by default asking you to identify the fields you want to use in the onn. Click

Primary Academic Program under the Headcount and Person Fact and Academic Program under
Academic Program. Then click the Left join selection and the red X to close the Join window.

Finally, double-click the Term table and set the join type to be a left join as you did in the two previous

examples.
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8. When you’re complete, your table connections should look like this.

Headcount and Person Fact ' () ' Academic Program

() ' Class
@ (i

9. Once your data connections are set, click Sheet 1 to navigate to your first worksheet.

Data | Analytics s

Your Data window is grouped by Data Source table by default and will

look like this. U Headcount and Person Fact+ (...

Dirmensions EL
4 E 'Academic Program$’

Abc Academic Org
files. fbc Academic Program

Now when creating visualizations, you can include fields from all of the

abc Academic Program Des..,
4 [E 'Headcount and Person F...
Abc Academic Career
#be Ethnicity
Abc Gender
Abec Primary Academic Pra..,
Abec Student Term
abc Withdrawal Code
4 B (lass$
abe Class Acad Career
abc Class Acad Org
#  Class Mumber
Abc Class Subject
Abe Student Term (Class)
4 B Term$%
abc Academic Career (Term)
Abc Student Term (Term)
Abc Student Term Description
abc Measure Naomes

Measures

Active Count
Emplid
Withdrawal Count
MNumber of Records
Measure Values

A
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Connecting to More than One Separate File

Data Blending

If you have files from more than one source you can still include these in the same visualization. You just need to
take separate steps to join them in Tableau. When using a Data Blend, the secondary data is aggregated when
joined to the first. You can practice this in our third example.

1. In Tableau, on the File menu click New to open a new session. This time we’ll connect to our data sources
directly in our Data window. Click Connect to Data.

ﬂ.} T F-i- |_IT|=I_T[
Data Analytics s

Connect to Data

Dimensions

The Data Connection selection from the Start Page will open.
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Excel

Text File

Click Excel and

as with our firs

perstore
Samnl
SAMMpe - U

World Indicators

Sheets

Enter sheet name

EE page

3 Click Sheet 1 to navigate to your worksheet.

[ili% = Maormal

Tableau Server

Actian Vector
Amazon Aurora
Arnazon EMR

Amazon Redshift

EXAScluticn
Firetird

(C.aval

Google BigQuery
Google Cloud SQL
Homonworks Hadoop Hive
HP Vertica

IEM Biglnsights
IBM DB2

IBM Netezza

MapR Hadoop Hive

MarkLogic

-

pction page. Notice that

In order to connect to a second table, on the Data menu select New Data Source.
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File [ Data ] Worksheet Dashboard  Story  Analysis  Map  Forma
++:I+ Mew Data Source Ctrl+D
Data Paste Data Ctrl+¥
B Cd
e Refresh All Extracts...
Di Rd
Ims Tableau Data Server r
Abc 2
Abc 4 Edit Relationships...
* Replace Data Source...
abc f
Abc B Upgrade Data Sources...
#b -
Ahc ) v page (Tableau Training_Enrollment_Fact_21 Jan) O
c !
Abc | Measure Names

Select Excel and then choose Class Dimension.xlIsx. This will bring you again to the Data Connection

window. This time you’ll notice that again there is only one table displayed but this time the preview
shows the data from the Class Dimension file.

You do have the option to switch between data sources by clicking the orange arrow to the left of the

data source name. However, you do not have the option to define the connections between the tables
here.

© page (Tableau Training_Enr

page (Tableau Training_Class Dimension_21 Jan)
v page (Tableau Training_Enrcliment_Fact_21 Jan)

Add New...

Sheets
Enter sheet name

EH page

6 Click Sheet 1 to return to your worksheet.

In the Data window notice that you now have two data sources shown, both Enrollment Fact and Class
Dimension. The Dimensions and Measures will reflect the specific Data source you have selected.
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Data Analytics %

EI page (Class Dimension)

Eﬂ page (Enrollment Fact)

Dimensions E Q|-
Abc Class Acad Career
Abc Class Acad Org
# Class Number
Abc Class Subject
#  Student Term

abe  Measure Names

8. You’ll want to ensure that the two files have the correct relationships defined. To do this, click the Data

menu and select Edit Relationships. Note: you can only create relationships for Dimensions. Since a
relationship is required between Student Term on both files, ensure that this field is set as a Dimension.

#*| Tableau - Book1

File | Data | Worksheet Dashboard Story A
ﬁ_} [_:.;. Mew Data Source Ctrl+Dr
Da Paste Ctrl+V
B Refresh All Extracts...
B Edit Relationships...
Dir Replace Data Source...
Al Tableau Data Server k
Abi
1+ »  page (Class Dimension) ¥
a5 page (Enrollment Fact) r
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The Relationships window will open. You can select the table you want to be primary in your join here.
Tableau will automatically attempt to map the two tables based on matching column descriptions. You
can choose to leave the mapping or make changes by adding, editing, or removing these selections by
selecting the Custom radio button. For our example, we will accept the mapping that Tableau has
suggested. Click OK to close the window.

Relationships >
Relationships determine how data from secondary data sources are joined with primary data sources.
Primary data source:

page (Enrolment Fact) -
Secondary data source: ® Automatic () Custom

page (Class Dimension) Class Mumber Class Mumber

Student Term Student Term
Add... Eit.... Remove
Cancel

9. Tableau defines a left outer join relationship when tables are joined in this way. When adding fields to a

visualization, be mindful that you add fields from the table you want to be primary. Your results may
change depending on which table is primary.

10. Drag the Dimensions Student Term and Class Number to Rows.

Enrollment Fact is now the primary file and will be indicated with a blue check mark.

L1

Data Analytics

H page (Class Dimension)

E& page (Enrollment Fact)

Click your other file, Class Dimension, and drag the Dimension Class Subject to Rows to the right of Class
Number. Notice that the field from the secondary file has an orange check mark next to it.
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o
Columns

i= Rows Student Term Class Number Class Subject =

Additionally, the file will be indicated with an orange check mark in the Data window. The fields joined to
the primary file will also have orange links next to them.

Data Analytics ¥

[_:.‘5 page (Class Dimension)

t& page (Enrollment Fact)

Dimensions ED v
abc Class Acad Career

Abe Class Acad Crg

# Class Number ==
Abc Class Subject

# Student Term ==
Abc Me

It’s important to understand how the interaction between these tables can affect your results. Because

of the left outer join, if you set a more restrictive table as primary your results will not include the full set
of data from your other file.

11. To demonstrate this point, we’ll create a second worksheet but bring the fields to our visualization in the
opposite order. Click the New Worksheet icon to the right of Sheet 1.

T
12. First drag Class Subject from Class Dimension to Rows. Notice that Data Analytics s
the blue check mark is now next to this table indicating that it is < _
primary. When you click Enrollment Fact, notice that the two links e page (Class Dimension)
are shown as broken. H page (Enrcliment Fact)
Dimensions E D | -
abe Academic Career
Abc  Academic Program
. . . . L H# Class Number cfo
13. Click a link to activate it. This will set Enrollment Fact as secondary :
and will show an orange check mark next to the file name. Rl ESREICIRY
14. Drag the Dimensions Student Term and Class Number to Rows to e G
. . N . Student Ter JE
the left of Class Subject. Notice this time the secondary file i _ _u T £
indicator is shown against these two fields. ol
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o
Columns

i= Rows Student Term 55 | Class Number % || Class Subject

15. Compare the two worksheets and notice the differences in the data. Even though they have the same

fields in the same order, because of the join limitations they are showing different results. As you’re
building your visualizations, it’s important to understand these mechanics in order to ensure you are
delivering the expected results.

Cross Database Joins

Joining functionality has been greatly enhanced with the advent of Tableau 10. The capability now exists to join
multiple data sources together within the Data Source window. The view and options available are the same as
those seen when joining multiple tabs of an Excel workbook.

1. In Tableau, on the File menu click New to open a new session. Click the Go to Start Page icon.

\ File Data Worksheet Dashboard Story  Analysis Map  Format  Server Window  Help
[ ]
e B AR & i - Norr
Data Analyti ® -
naitics Pages Columns
Connect to Data
H R oyae

2 Click Excel to connect to an Excel file.
Select Enrollment Fact.

Connect

Excel

is will look the same as it did when opening any Excel file. You have the same

Access

gle or multiple tabs exist.
Statistical File

Other Files
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4.

5.

In order to connect to a second file, click on the Add link next to the Connections header.

- .
| Tableau - Bookl

Adc
| Enrollment Fact
Excel
Sheets o

Use Data Interpreter

Data Interpreter might be able to
clean your Excel workbook.

EE page

B- page (Enrollment Fact)

| page

Indicate the file you’d like to open selecting from the connection options available.

# € > EC
Connections Add

Enroliment Fact

Exce

Sheets o

Use Data Interpreter

Data Interpreter might be able to
clean your Excel workbook

@ page

B3R Mew Union

Select the Excel file Class Dimension.

Add a Connection

Actian Matrix

Actian Vector

Amazon Aurcra
Amazon EMR

Arnazon Redshift
Anaplan

Aster Databaze

Cisce Information Server
Cloudera Hadoop

DataStax Enterprice

ud SOL

le Sheets
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6. Notice that Tableau will automatically set the join if there is only one tab.

Connections

Enrollment Fact

Class Dimension
Exce

Sheets o

Use Data Interpreter

Data Interpreter might be able to
clean your Excel workbook.

B8 page

8- page+ (Multiple Connections)

I page

@ pagel

Also, notice that each connection is identified with a color that corresponds to its data connection.

You have the same options for defining the join types as outlined when explored with the multi-tabbed

Excel file.
| e O
Jain X
Inner Left Right Full Cuter
Data Source pagel
Class Mumber = Class Mumber (pag...

Tableau will automatically try to join on matching field names. If the initial join is not correct, fields may

be added or removed and the join type changed. For our exercise, leave Class Number as the only join
field and change the join type to a left join by clicking Left and then click the red X to close the Join window.

7. When complete, your connections should look like this.
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B- page+ (Multiple Connections)

I page ‘) 1 pagel

8. Once your data connections are set, click Sheet 1 to navigate to your first worksheet.

Data Analytics s

8 page+ (Multiple Conne...

Dimensions EpPp |-
v B page
Abc  Academic Career
aAbe  Academic Program
# Class Number
abc  Ethnicity
Abc Gender
v B pagel
Abc Class Acad Career
abe Class Acad Org
# Class Number {pagel)
abc Class Subject

Abc  Measure Mames

Measures
v B page
Dropped Gount
Emplid
Enrolled Count
Grade Point
Student Term
Units Taken
« BE pagel

# Student Term (pagel)
= Mumber of Records

#  Measure Values

# # #F H H# H#
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